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Installing
Below you will find general information on the system specifications for pdfToolbox as well as how to install and activate the soft-
ware.

System Requirements

pdfToolbox runs as Standalone version or as Plug-In under Adobe® Acrobat® X Pro, Adobe® Acrobat® 9 Pro, Adobe® 
Acrobat® 8 Professional or Adobe® Acrobat® 8 3D.

 ! Please note that annotations can currently not be displayed with the pdfToolbox Standalone version and that form 
fields cannot be edited. JavaScripts will be ignored.

Installing the Software

To install the software start pdfToolbox Installer. The installation program will then take you through the necessary 
steps. If you installed the Plug-In version you will find the entries for pdfToolbox under the Plug-Ins menu the next time 
you start Adobe Acrobat. In addition, the accompanying documentation to pdfToolbox is installed. 

Activation
In order to use pdfToolbox you need to activate the software. If you want to buy callas pdfToolbox you can do so via one 
of our resellers or via our webshop. Further information can be found on our website under "Buy".

As soon as you have purchased a license for pdfToolbox you will receive a license code with which you can request the 
activation information for the software. The activation dialog will open up automatically on startup of pdfToolbox if it 
has not been activated already. Alternatively you can access this dialog via the menu entry "Activation or trial version" 
under "pdfToolbox Miscellaneous" in the Plug-In or in the Help menu of pdfToolbox Standalone.

To request the activation information, enter your name, optionally the name of your company and select the desired 
license type. If you already received a license code, enter it in the license code field. Otherwise select the kind of trial 
which you would like to receive an activation for. Shortly after requesting you will receive an E-Mail reply with a license 
file which is needed for the activation. 

Drop this license file in the yellow part of the window and press the "Activate" button. Alternatively you can copy the 
body text from the response E-Mail to the "Response" text field. 

Be sure to keep your license code in a safe place, and do not forget to send a copy of your completed registration card 
to callas software. Only registered clients are entitled to updates and technical support. Should you ever mislay your  
license code, we can replace it quickly and easily.

! Supported Operating systems:
– Mac OS X 10.4 or newer, Intel or PPC  
– Windows 2000/XP/Server 2003/Vista/Server 2008/7

! pdfToolbox can not run as a plug-in with the free 
 version of Adobe Reader!

    
pdfToolbox toolbar icon

! In order to activate pdfToolbox for all user accounts 
of one machine, the license file can be moved from the user 
folder of the user who has performed the activation to the 
following location: 
 
Windows: <All Users user preferences>\Application data\  
  callas software\callas pdfToolbox 5 
Macintosh: /Library/Preferences/callas software/ 
  callas pdfToolbox 5

pdfToolbox Manual
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! The Switchboard offers a wide range of functionality.
 Every action contains a short description and the most  
 important options for configuration. 
 

You can also add profiles, fixups and checks by selecting 
"Workspace" from the menu next to the chosen entry.

Switchboard
Following some examples are shown how easy the Switchboard actions can be used.

Example 1: Booklet

In the "Arrange" section you will find the "Booklet" action which allows you to create a booklet of a file with multiple 
pages. You can define if cutting marks should be added to each resulting page automatically as well as the sheet size 
and the horizontal and vertical offset.

 

www.callassoftware.com
mailto:info@callassoftware.com


callas software gmbh · Schönhauser Allee 6-7 · 10119 Berlin (Germany) · Tel +49.30.44390310 · www.callassoftware.com · info@callassoftware.com 5

Example 2: Convert to B/W

In the "Colors" section you will find the "Convert to B/W" action which allows you to convert any file to grayscale. This 
is especially useful for printing documents for lower costs on digital printing machines.

 

! You can navigate easily thru multipage PDF-documents 
 using the following shortcuts: 
 Pos 1  First page 
 Page up Previous page 
 Page down Next page 
 End  Last page

! If you have any questions or problems please contact   
 us by using the function "Support" at "Get in contact"   
 in the Switchboard or using the contact form at: 
 www.callassoftware.com or via email to: 
 support@callassoftware.com

pdfToolbox Manual
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Example 3: Commercial CMYK+spot

In the "Standards" section you will find the "Commercial CMYK+spot" action which will prepare your PDF for printing 
according to the GWG specification for commercial printing, so you will receive a production ready file with one click. 
This action will perform necessary color conversions as well as all corrections needed for PDF/X-1a compliancy.
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Example 4: Organizing pages

In the "Pages" section you will find the "Organize pages" action which gives you the opportunity to re-arrange the 
pages order of all open PDF documents. Single pages can be dragged and dropped in any order you desire. You can 
also easily duplicate pages or have a quick look at them by using the respective entry in the context menu when  
clicking on a page. Clicking on "Apply" will create new documents with the prepared page order.

You can easily navigate with mouse and keyboard through 
the "Organize pages" dialog: 
– Space: Quick view of current selection 
– Del: Move current selection to trash 
– Mouse click: Select one/first page 
– cmd + Mouse click:  Select n/last page (in combination  
  with previous action allows to   
  select range of pages within one   
  document) 
– drag'n'drop:  Move pages 
– alt + drag'n'drop:  Copy pages

pdfToolbox Manual
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Explore

The Visualizer

The Visualizer lets you inspect a page in regard to relevant printing aspects, such as ink coverage, color spaces or page 
object types. You will find it in the section "Reports" and in the Standalone version under the menu entry "View". Due 
technical reasons this function is in the Acrobat plug-in only available in Acrobat version 9.

 

The ink coverage e.g. can be highlighted concerning the problematic parts or in a topographic view, similar to a map.

pdfToolbox Manual

! You can easily navigate via shortcuts through the 
 "Visualizer" dialog: 
 – cmd + left arrow:  Next mode 
 – cmd + right arrow:  Previous mode 
 – left arrow:  Next view 
 – right arrow:   Last view 

You can also have a look at the different color separations 
or spot very small objects. 
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Explore Metadata

In the section "Reports" you will find a button "Browse Metadata" that opens up  
another dialog that gives you a complete overview of all the metadata contained in the 
current document. This can also be opened via the entry "Metadata..." in the Acrobat 
"File" menu or the entry "Explore Metadata..." in the Plug-In or Standalone menu.

The Metadata Explorer does not only display the document's XMP Metadata but also 
Metadata belonging to the different page objects. It lists all objects including a small 
preview and their position on the page.

The Metadata can be exported as configurable XML report. A detailed explanation on 
how to create XML export settings can be found in the Reference manual.

pdfToolbox Manual
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Explore Layers

 

In the section "Layers" you will find a button "Browse Layer" that opens up another dialog that gives you a  
complete overview of all layers contained in the current document. This can also be opened via the entry "Layer..." in 
the Acrobat "File" menu or the entry "Explore Layers..." in the Plug-In or Standalone menu.

The upper part of the layer explorer window shows the layer views which are 
named OCCD in PDF syntax. A layer view defines the visibility of each individu-
al layer.

The "Actions menu" allows for creating, modifying and saving layer 
views.

Such layer groups will show up as such in the Acrobat 9 layer palette, if  
the PDF is saved as PDF/X-4 file. This can easily be achieved by using the  
"PDF/X-4" action of the "Standards" group.

The lower part of the window shows the individual layers, which are named 
OCG in PDF syntax. The "Actions menu" allows for creating, renaming or de-
leting existing layers.

Saved layer view settings can also be applied via the Power Tools' Fixup  
"Apply OCCD". 

pdfToolbox Manual

If no layers are present in the current PDF file, the Layer 
Explorer will display the available options to create new 
layers with pdfToolbox.
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The Power Tools
Besides the predefined single actions you can perform custom analysis and correction of your files.  
Therefore pdfToolbox offers the power tools "Profiles", "Checks" and "Fixups" which can be opened via the "Plug-Ins" 
menu of Acrobat ("pdfToolbox Profiles...") or the "Tools" menu in the Standalone version. Here you have countless 
possibilities to create own checks and corrections in whatever combination you need them.

Profiles

"Profiles" offers action plans combining analysis and adjustments. You can choose from a list of predefined profiles 
or set up your own with various checks and/or corrections. In order to do so choose "Create new pdfToolbox 4 profile" 
from the "Settings" menu.

In the upcoming dialog you can select common checks for the different areas or create custom fixups and checks. 
Fields marked with this symbol might be filled with variables that can be altered during runtime. When clicking on 
this symbol a new dialog will open where you can define a variable name and a default value. When running this 

profile a dialog will come up and ask you for the actual value to use. 
Detailed information on creation and modification of pdfToolbox 4 profiles, as well as the use of dynamic profiles,  
is described in the section "Use of kfpx profiles" of the "callas pdfToolbox 4 Reference" manual.

Checks

"Checks" offers quick analysis of your PDF files.

Fixups

"Fixups" offers manipulation of PDF files in many ways. 

When running a profile you can decide whether you only want to analyze your file or if you also want to perform fixes 
contained in the profile.

You can export all profiles, checks and fixups as .kfpx files to use in pdfToolbox Server/CLI/SDK 4. Of course you can 
also import existing profiles into pdfToolbox Plug-In or Standalone.

All Power Tools keep their options organized in groups

The different sections of the Edit dialog are described in 
detail in the Reference manual.
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! Because of different rendering of font and vectorized   
 text Acrobat might display objects differently after   
 converting fonts to outlines. As this is an Acrobat  
 rendering issue the difference is no longer visible when   
 zooming closer or outputting on a high resolution   
 device.

Results and Reports

Each check has a defined severity (Error, Warning or Info) with which it will hit. If a hit is created for a certain object 
you can have a look at the object properties when you open up the tree entry for that object hit. You can locate the ob-
ject in the PDF via double clicking on the entry or hitting the "Show" button. When you click on "Show in Snap" a new 
window will be opened that shows you this object isolated from the other document’s contents.

You can influence the richness of detail in the result view via the Preferences dialog of pdfToolbox.

All results can be saved as a report. Available report types are Text, XML and PDF, whereas the last can either contain 
problems highlighted as masks, comments or layers. Besides this, you can add the results directly as comments into 
the PDF document.

Also you can create an inventory report for the current PDF which will list all used resources like fonts and colorspace 
with more details.
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The Expert Tools
pdfToolbox provides two more tools, giving you insight into the depths of PDF files and fonts, discovering the data 
structure. This normally is not needed for common use, but might be helpful if you encounter a damaged file or if  
you simply are interested in learning more about the internal structure. The entries "Explore PDF..." and "Explore 
Fonts..." can be found inside the "Plug-Ins" menu of Acrobat ("pdfToolbox Miscellaneous") or the "Tools" menu in the 
Standalone version. 

Preferences
The Preferences dialog offers options to define the amount of details for objects in the result view, how problems 
should be highlighted when creating a report and also offers an editor to create and modify Output Intents. 

General

Here you can limit the number of hits per page and docu-
ment and define the amount of details which should be 
shown in the result dialog.

Output Intents

Here you can create and modify Output Intents, export or 
capture ICC profiles.

Highlighting

Here you can define the highlighting colors and style which 
should be used for showing objects in the PDF document or 
for the transparent masks in the PDF with masks report.

You can also reset all warning dialogs in the preferences.

With the "Explore PDF" tool you can have a look into the 
data structure of a PDF file, exposing the several commands 
and details that are forming the page objects.

In the "Explore Fonts" dialog you will find information 
about e.g. font type and embedding state of all fonts  
present in the current document.
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Purpose of DeviceLink Conversion
DeviceLink profiles complement the usage of regular ICC profiles to avoid weaknesses of a color conversion based 
on ICC profiles for certain tasks. These weaknesses mainly are the CMYK to CMYK transformation and e.g. the pres-
ervation of pure black text in a picture. A CMYK to CMYK transformation with ICC profiles is always performed via the 
device independent Lab color space, which leads to a complete reseparation of the data with partly unpredictable and 
unwanted results. This does not happen with DeviceLink profiles, which offer a direct control of color composition.  
The optional DeviceLink Add-on is delivered with a package of the most common DeviceLink profiles (for details see 
section "Use of color conversion" in the "callas pdfToolbox Reference").

Using your own DeviceLink profiles
You can easily use your own profiles for DeviceLink conversion with pdfToolbox. All you need to do is click on the  
button "Import" in the DeviceLink conversion action or the fixup "Convert colors using DeviceLink profiles" and choose 
a profile from your system. An XML file with the description text and a PNG file with the icon (all 3 with identical name, 
just differing in the suffixes) will be created automatically. These can be adapted to your needs.

 ! Please note that profiles need to have an .icc suffix to be importable.

Sample XML file

<?xml version="1.0" encoding="UTF-8" ?>

<devicelink>

 <profile lang="ENU">

  <header>DeviceLink_ISOcoatedV2_280_GCR70</header>

  <explanation>This text describes the functionality of the selected DeviceLink profile.</explanation>

 </profile>

</devicelink>

If you want to change the XML file please make sure to save it as UTF8. 
You can also define several description texts for the different languages: Just copy the section marked with "ENU" and 
mark it e.g. with "ESP". As long as only the "ENU" section is present, it will be used for all languages.

Sample PNG file
 

The PNG file needs to be 64x64 pixels. 

! The files for using your own DeviceLink profiles will be   
 stored in  
 <User preferences folder>\Application data\ 
 callas software\callas pdfToolbox 5.0\ 
 DeviceLink" on Windows and in  
 "/Users/<user>/Library/Preferences/callas software/ 
 callas pdfToolbox 5.0/DeviceLink" on Mac.

pdfToolbox Manual
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Behind the Scenes
Following you find a list of the actions in the Switchboard that perform certain fixups when executed.

Standards

Action Performed fixups

PDF/X-1a – Add "_X1a" to PDF file name after processing 
– Apply transfer curves 
– Auto-correct nesting of page geometry boxes 
– Convert Color  
   (Convert RGB elements to the defined Output Intent. Calibrated CMYK and Gray is decalibrated.) 
– Convert to PDF/X-1a (2001) 
– Discard all actions (including JavaScript actions) 
– Discard all embedded files 
– Discard all external cross references 
– Discard all form submission, import and reset actions 
– Discard Black Generation (BG) parameters 
– Discard embedded PostScript 
– Discard hidden layer content and flatten visible layers 
– Discard image interpolation flag 
– Discard OPI information 
– Discard Under Color Removal (UCR) parameters 
– Embed fonts (even if text is invisible) 
– Flatten transparency (high resolution) 
– Make spot color appearance consistent 
– Move all annotations out of page area (except TrapNet annotations) 
– Recompress LZW as ZIP 
– Reduce bit depth for 16 bit images to 8 bit 
– Remove all alternate images 
– Remove all form fields 
– Remove ArtBox 
– Remove document structure compression 
– Save as PDF 1.3 (Acrobat 4) 
– Set Creation date entry 
– Set Modification date entry 
– Set OutputIntent 
– Set Title to file name if missing 
– Set Trapped key to "false" if Trapped key is neither "true" nor "false" 
– Set transparency blend color space (to DeviceCMYK) 
– Set TrimBox to CropBox (if no TrimBox defined)

pdfToolbox Manual
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Action Performed fixups

PDF/X-3 – Add "_X3" to PDF file name after processing 
– Apply transfer curves 
– Auto-correct nesting of page geometry boxes 
– Convert Color 
– Convert to PDF/X-3 (2002) 
– Discard all actions (including JavaScript actions) 
– Discard all embedded files 
– Discard all external cross references 
– Discard all form submission, import and reset actions 
– Discard Black Generation (BG) parameters 
– Discard embedded PostScript 
– Discard hidden layer content and flatten visible layers 
– Discard image interpolation flag 
– Discard OPI information 
– Discard Under Color Removal (UCR) parameters 
– Embed fonts (even if text is invisible) 
– Flatten transparency (high resolution) 
– Make spot color appearance consistent 
– Move all annotations out of page area (except TrapNet and PrinterMark annotations) 
– Recompress LZW as ZIP 
– Reduce bit depth for 16 bit images to 8 bit 
– Remove all alternate images 
– Remove all form fields 
– Remove ArtBox 
– Remove document structure compression 
– Save as PDF 1.3 (Acrobat 4) 
– Set Creation date entry 
– Set Modification date entry 
– Set OutputIntent 
– Set Title to file name if missing 
– Set Trapped key to "false" if Trapped key is neither "true" nor "false" 
– Set transparency blend color space 
– Set TrimBox to CropBox

pdfToolbox Manual
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Action Performed fixups

PDF/X-4 – Add "_X4" to PDF file name after processing 
– Adjust layers for PDF/X-4 
– Apply transfer curves 
– Auto-correct nesting of page geometry boxes 
– Convert Color 
– Convert to PDF/X-4 
– Discard all actions (including JavaScript actions) 
– Discard embedded PostScript 
– Discard OPI information 
– Embed fonts (even if text is invisible) 
– Make document XMP Metadata compliant with PDF/X-4 
– Make spot color appearance consistent 
– Move all annotations out of page area (except TrapNet and PrinterMark annotations) 
– Recompress LZW as ZIP 
– Remove all form fields 
– Remove ArtBox 
– Remove Differences array from TrueType fonts 
– Remove halftone if not PDF/X compliant 
– Remove ICC source profiles if identical to profile in Output Intent 
– Set OutputIntent 
– Set Title to file name if missing 
– Set Trapped key to "false" if Trapped key is neither "true" nor "false" 
– Set transparency blend color space 
– Set TrimBox to CropBox
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Action Performed fixups

PDF/X-4p – Add "_X4p" to PDF file name after processing 
– Adjust layers for PDF/X-4 
– Apply transfer curves 
– Auto-correct nesting of page geometry boxes 
– Convert Color 
– Convert to PDF/X-4p 
– Discard all actions (including JavaScript actions) 
– Discard embedded PostScript 
– Discard OPI information 
– Embed fonts (even if text is invisible) 
– Make document XMP Metadata compliant with PDF/X-4 
– Make spot color appearance consistent 
– Move all annotations out of page area (except TrapNet and PrinterMark annotations) 
– Recompress LZW as ZIP 
– Remove all form fields 
– Remove ArtBox 
– Remove Differences array from TrueType fonts 
– Remove halftone if not PDF/X compliant 
– Remove ICC source profiles if identical to profile in Output Intent 
– Set OutputIntent 
– Set Title to file name if missing 
– Set transparency blend color space 
– Set Trapped key to "false" if Trapped key is neither "true" nor "false" 
– Set TrimBox to CropBox

Commercial CMYK All fixups performed with "PDF/X-1a" plus 
– Compress all uncompressed objects using lossless ZIP compression 
– Convert alternate color space for spot colors to CMYK (ISO Coated v2 (ECI))  
– Discard all JavaScripts 
– Discard flatness tolerance 
– Discard halftone information 
– Discard smoothness tolerance 
– Downsample bitmap images to 2400 ppi if above 3600 ppi 
– Downsample color images to 300 ppi if above 450 ppi 
– Downsample grayscale images to 300 ppi if above 450 ppi 
– Move annotations out of page area, remove TrapNet, PrinterMark, Custom and all multimedia annotations 
– Remove page objects which are completely outside of page area 
– Remove page scaling factor 
– Remove Rendering Intents 
– Set black text below 12 pt and black vector objects to overprint 
– Set white text to knock out 
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Action Performed fixups

Commercial CMYK+spot See "Commercial CMYK" (uses "ISOcoated v2 (ECI)" as Output Intent)

Magazine Ad See "Commercial CMYK" (uses "ISOcoated v2 300 (ECI)" as Output Intent)

Newspaper Ad See "Commercial CMYK" (uses "ISOnewspaper26v4" as Output Intent)

Digital (color) – Apply transfer curves 
– Compress all uncompressed objects using lossless ZIP compression 
– Convert color to 4c for digital printing 
– Discard Black Generation (BG) parameters 
– Discard embedded PostScript 
– Discard flatness tolerance 
– Discard halftone information 
– Discard image interpolation flag 
– Discard OPI information 
– Discard smoothness tolerance 
– Discard Under Color Removal (UCR) parameters 
– Downsample color images to 300 ppi if above 450 ppi 
– Downsample grayscale images to 300 ppi if above 450 ppi 
– Flatten transparency (medium resolution) 
– Force blend color space to DeviceCMYK 
– Recompress LZW as ZIP 
– Reduce bit depth for 16 bit images to 8 bit 
– Remove all alternate images 
– Set minimum line width to 0.14 pt

Digital (B/W) – Apply transfer curves 
– Compress all uncompressed objects using lossless ZIP compression 
– Convert color to B/W 
– Convert registration color to CMYK black only 
– Discard Black Generation (BG) parameters 
– Discard embedded PostScript 
– Discard flatness tolerance 
– Discard halftone information 
– Discard image interpolation flag 
– Discard OPI information 
– Discard smoothness tolerance 
– Discard Under Color Removal (UCR) parameters 
– Downsample color images to 300 ppi if above 450 ppi 
– Downsample grayscale images to 300 ppi if above 450 ppi 
– Flatten transparency (medium resolution) 
– Force blend color space to DeviceCMYK 
– Recompress LZW as ZIP 
– Reduce bit depth for 16 bit images to 8 bit 
– Set minimum line width to 0.14 pt
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Action Performed fixups

Web offset CMYK See "Commercial CMYK" (uses "ISO Web Coated (ECI)" as Output Intent)

Web offset CMYK+spot See "Commercial CMYK" (uses "ISO Web Coated (ECI)" as Output Intent)

Prepress

Action Performed fixups

Increase line width – Increase line width

Flatten transparency – Flatten transparency

Overprint &  
Knockout

– Overprint black 
– Knockout white vector and/or text objects

Output Intent – Embed Output Intent

Add marks – Add crop and bleed marks

Create TrimBox – Derive page geometry boxes from crop marks

Document

Action Performed fixups

Optimize PDF Rewrites and optimizes the internal structure of the PDF. In addition the PDF is saved for Fast Web View. 
The same processing is done during any savving of a PDF-file.

Resave as PDF 1.x – Set PDF Version

Pages

Action Performed fixups

Scale by percent – Scale pages

Rotate – Rotate pages

Scale page content only – Scale page content only

Flip – Flip pages

Crop to visible – Crop all pages to bounding box

Create bleed – Create bleed

Fonts
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Action Performed fixups

Embed font – Embed missing fonts

Subset font – Subset fonts

Font to outlines – Convert fonts to outlines

Colors

Action Performed fixups

Spot Colors – Map spot colors

DeviceLink conversion Profiles: "Convert using Device Link ..."

Tone value adjustment – Adjust dot gain

Convert to B/W – Convert color to grayscale 
– Convert registration color to CMYK black only

Remove ICC profiles – Remove ICC profile(s) form Output Intent(s)

Registration color – Convert registration color to CMYK black only

Correct 4c Black – Correct 4c Black

Brightness – Adjust dot gain

Images

Action Performed fixups

Downsample – Downsample/compress color images 
– Downsample/compress grayscale images 
– Downsample/compress monochrome images

Recompress – Downsample/compress color images 
– Downsample/compress grayscale images 
– Downsample/compress monochrome image

Layers

Action Performed fixups

Flatten layers – Discard hidden layer content and flatten visible layers

Form fields by type – Adjust or remove form fields

Comments by author – Adjust or remove annotations
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mailto:info@callassoftware.com


hc

n
Schönhauser Allee 6-7 
D-10119 Berlin (Germany) 
Tel +49.30.4439031-0 
Fax +49.30.4416402 
info@callassoftware.com 
www.callassoftware.com

mailto:info@callassoftware.com
www.callassoftware.com

	Installing
	System Requirements
	Installing the Software

	Activation
	Switchboard
	Example 1: Booklet
	Example 2: Convert to B/W
	Example 3: Commercial CMYK+spot
	Example 4: Organizing pages

	Explore
	The Visualizer
	Explore Metadata
	Explore Layers

	The Power Tools
	Profiles
	Checks
	Fixups
	Results and Reports

	The Expert Tools
	Preferences
	General
	Output Intents
	Highlighting

	Purpose of DeviceLink Conversion
	Using your own DeviceLink profiles
	Sample XML file
	Sample PNG file

	Behind the Scenes
	Standards
	Prepress
	Document
	Pages
	Fonts
	Colors
	Images
	Layers



